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Getting Started
Introduction

Introduction

The 86 100CU-400 PLL and Jitter Spectrum Measurement Application is a collection
of Microsoft® Excel workbook applications that perform Jitter Transfer Measurements
(phase locked loop measurements), jitter spectrum, and jitter phase-noise measure-
ments. These workbook applications run on a PC and control an 86100C digital communi-
cations analyzer and data, clock, and jitter sources via a GPIB or LAN connection as
shown in Figure 1-1.

e Before you do anything else, refer to “Quick Start Guide” on page 1-4.

NOTE AGILENT PROVIDES THIS FREE SOFTWARE "AS IS". ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO ANY WARRANTY OF NON-
INFRINGEMENT, THE IMPLIED WARRANTIES OF MERCHANTABILITY,
SATISFACTORY QUALITY, REASONABLE CARE AND SKILL, AND FITNESS FOR A
PARTICULAR PURPOSE ARE EXPRESSLY DISCLAIMED.

Y

PLL and Jitter Spectrum Compliance Specific
Measurement Application Workbook Application

A

86100C DCA-J

Data Source

Clock Source
GPIB / LAN

Jitter Source

Figure 1-1. Required Workbooks, PC, and Test Equipment
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Getting Started
Introduction

General JTF, jitter spectrum, or jitter phase-noise measurements are performed using the
PLL and Jitter Spectrum Measurement workbook. Compliance-specific workbook appli-
cations make it easy to perform measurements that are targeted for a specific measure-
ment standard as they automatically

e configure the 86 100CU-400 PLL and Jitter Spectrum Measurement Application
workbook,

e collect the returned data,
¢ and present the measurement results.

As shown in Figure 1-1 on page 1-2, compliance-specific workbooks do not communicate
directly with the instruments. Because they configure many of the settings for you, you
do not have configure the main workbook. When using the 86100CU-400 PLL and Jitter
Spectrum Measurement Application workbook to perform Jitter Transfer Measure-
ments, jitter spectrum, and jitter phase-noise measurements, you'll need to configure the
individual settings as described in this chapter.

The compliance-specific workbooks are not locked, so you can modify them to meet your
measurement needs. Before modifying these workbook, it is recommended that you be
experienced the techniques required. Always make a backup copy before modifying any
workbook. Agilent does not provide any support for modifying these workbooks.

You can use one or more of the following methods to connect the test equipment to the
PC:

GPIB using an Agilent 82350B GPIB interface PCI card
GPIB using an Agilent 82357A or 82357B USB-to-GPIB converter
LAN using an E5810A LAN/GPIB gateway

National Instruments based GPIB or LAN connections

GPIB and LAN instrument control is supported by the Agilent IO Libraries Suite which is
shipped on a disc with the 86100C. This software includes the Agilent Connection Expert,
which facilitates the sending of remote commands to the instrument by using a GPIB or
LAN device address. If you can not establish a LAN connection on the 86100C, install the
Agilent IO Libraries LAN patch. This patch is located on the 86100C at C:Infini-
iumInstallenAgtinstloLanPatch.msi. An IP address can be substituted instead of using domain
names.

SICL/LAN support requires that two programs be unblocked by the instrument’s firewall.
If you upgraded the instrument firmware versions A.07.00 and below to revision A.08.00
and above, you might be prompted by a firewall application to block the Agilent Remote I/
O Port Mapper Utility and the Agilent Remote 1/O Server. If you decide to allow the fea-
tures to be blocked, then remote control of the DCA over SICL/LAN will not be possible.
We recommend that you select Unblock on these features. However, if you block these
features, you can always reconfigure the firewall at a later time to allow SICL/LAN.

Some firewall applications might block an echo request (ping) from the Agilent Connec-
tion Expert version 15.0 and above. If a ping is blocked the "Instrument I/O on this PC"
auto-detect function will not find the 86100C DCA even though it has been added and
tested correctly under the Change Properties dialog box. To resolve this on the Microsoft
Windows Firewall, refer to “Step 3. Setup the Communications Bus” on page 2-4.

For more information on communicating with the instrument using the Agilent's 10
Libraries Suite, refer to the book IO Libraries Suite Connectivity Guide with Getting
Started.
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Quick Start Guide

Confirm that you have the required test equipment and software. Refer to “Required
Equipment” on page 1-5.

Follow the instructions in Chapter 2, “Installing the Application”.

To perform Jitter Transfer Function (JTF) compliance testing with one of the PCI Express
compliance workbooks, setup the compliance-specific workbooks as explained in “To
Configure the PCI Express Workbooks” on page 3-6.

To perform general JTF, jitter spectrum, or jitter phase-noise measurements, refer to “To
Configure the PLL and Jitter Spectrum Workbook” on page 3-3.

Perform your measurement using the procedures in Chapter 4, “Making Measurements”.
The instructions in this user’s guide assume that you are familiar with using the 86100C

and can lock the trigger on the signal. If not, refer to the 86100C online help. It is also
assumed that you know how to use Microsoft Excel.
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NOTE

Required Equipment

Table 1-1 lists the compatible equipment that you can use in your test setups. As shown,
instruments like the N4903A can be used as the source for both the data, clock, and jitter.
Be sure to select an instrument that meets your measurement needs. For example, a jit-
ter source is only required for Jitter Transfer Measurements (JTF). Also, ifferent jitter
sources offer varying ranges of jitter.

The 86100CU-400 PLL and Jitter Spectrum Measurement Application will not work
with 86100A, 86100B, or 83496 A products. An 83496 A can be upgraded to an 83496A-UAB
which is compatible. Contact your local Agilent representative for details.

Table 1-1. Compatible Test Equipment

- S E
e = 5 =
, ° =8 =
£ @ B = 2 =
2T @ 5 8 < 8
= T = > . =R L] ~ &
< =3 € S E @ s 2
S & s 2 s = o
w @ S 2 = © o
-2 o 2 X = 2= 8 = c
o = = 2 & = L e 2 E
-~ £ Q = e
< m < S E < = < & ad < =
[-=] © © e O ® & S = ~N = =
= =] =] = &= o = © = n =
- = = 25 =) = 2 N E S ®
8 b 23 Za 2% S < &= 8=
Jitter Receiver R . .
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Clock Source . o o o
Jitter Source ° . . . . .
a. Required for the JTF measurement.
Computer Available hard drive SPACe . ... ... . 100 Mb
RAM . 500 Mb
(01071 >1GHz
Operating SYStemM. .. ... Windows® 2000, XP, or Vista

Microsoft Excel

One of the following hardware interfaces:
82357A/B GPIB-to-USB converter, or
823508 GPIB PCl card, or
E5810A LAN/GPIB gateway

Agilent 10 Libraries Suite (Revision 15.0 or later)

Excel 2003 with Service Pack 3 (SP3) or Excel 2007 with Service Pack 1 (SP1)
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Electrostatic Discharge Information

Electrostatic discharge (ESD) can damage or destroy electronic components. All work on
electronic assemblies should be performed at a static-safe work station. The following fig-
ure shows an example of a static-safe work station using two types of ESD protection:

e (Conductive table-mat and wrist-strap combination.

e (Conductive floor-mat and heel-strap combination.
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Figure 1-2. Static-safe Work Station

Both types, when used together, provide a significant level of ESD protection. Of the two,
only the table-mat and wrist-strap combination provides adequate ESD protection when
used alone. To ensure user safety, the static-safe accessories must provide at least 1 MQ
of isolation from ground. Purchase acceptable ESD accessories from your local supplier.

These techniques for a static-safe work station should not be used when working on circuitry
with a voltage potential greater than 500 volts.
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Installing the Application
Step 1. Obtain the Application

Step 1. Obtain the Application

1 Visit the Agilent’s download web page at:
www.agilent.com/find/jtf
2 Click Download.

3 Complete the registration form and click Submit.

2-2



Installing the Application
Step 2. Upgrade 86100C software

Step 2. Upgrade 86100C software

1 Confirm that the 86100C software revision is A.08.00 or above. On the 86100C, click Help
> About 86100C. The version is listed in the dialog box. If the software revision is below
A.08.00, perform the following steps.

2 Copy the software upgrade file to a USB Flash Drive, external USB CD-RW drive, LAN
folder, or other device so that the file will be available to copy to the 86100C.

3 On the 86100C File menu, click Exit and then click Yes to exit the 86100C application.
4 On the Windows Start menu, click My Computer.

5 Select the D: drive and create a new folder. Give the new folder a meaningful name. For
example, Software Upgrade.

6 Copy the upgrade file (.exe file extension) from an external memory device to your new
folder.

7 Select the upgrade file to begin the installation. Click Next twice for the installation wizard
to automatically uninstall the current version and install the newer version.

8 If you are prompted by a firewall application to block the Agilent Remote I/O Port Mapper
Utility and the Agilent Remote I/O Server, select Unblock as shown in Figure 2-1 on page
2-3. See the introduction to this section for more information.

9 On the Windows desktop, double click the program icon to start the 86100C. |

%2 Windows Security Alert g %2 Windows Security Alert
“b To help protect your computer, Windows Firewall has blocked “9 '] To help protect your computer, Windows Firewall has blocked
some features of this program. some features of this program.
Do you want to keep blocking this program? Do you want to keep blocking this program?
D Name:  Agilent Remote 170 Port Mapper Utility Name:  Agilent Remote 1/0 Server
Publisher. &gilent Technologies L) Publizher: Aailent Technologies

1
i

KeepBlocking | [ Unblock | [ askMelLater | KeepBlocking | [ Unblock | [ askMelLater |
PP —— R ———— C ot Sl n Aghnd b k| - — e
Agilent Remote 1/0O Port Mapper Utility Agilent Remote I/O Server

Figure 2-1. Example Windows Firewall Security Alerts

2-3
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Step 3. Setup the Communications Bus

Step 3. Setup the Communications Bus

If you use a USB to GPIB converter

Install the drivers that come with the USB to GPIB converter.
Install the manufacturer’s provided VISA libraries.

Connect the USB-to-GPIB converter to the computer.

Connect the GPIB cable from the converter to the instruments.
If you use a GPIB card

Install the GPIB card and load the supplied driver.

Install the manufacturer’s provided VISA libraries.

Connect the GPIB cable between the GPIB port on the control computer and the GPIB port
on the 86100C.

If you use a LAN connection

If you are controlling the 86100C over SICL/LAN with the Agilent Connection Expert, this
procedure describes configuring the Windows Firewall. Settings using a different firewall
will be similar.

On the 86100C, click Help > About 86100C and confirm that software revision A.08.00 or
above is installed.

Minimize the 86100C application to view the Windows desktop.
On the Start menu, click Control Panel.

If Category View is set, click Switch to Classic View.

Open Windows Firewall.

On the Exceptions tab, clear or select to unblock (allow) the Agilent Remote I/0 Port Mapper
Utility and the Agilent Remote I/0 Server. These programs allow control of the 86100C DCA
over SICL/LAN. If these utilities are not listed, click Add Program in the dialog box and add
them using the following paths:

Agilent Remote I/O Port Mapper Utility found at C:\Program Files\Agilent\IO Libraries
Suite\bin\portmap.exe

Agilent Remote I/0O Server found at C:\Program Files\Agilent\IO Libraries
Suite\bin\siclland.exe

2-4



Installing the Application
Step 3. Setup the Communications Bus

: Windows Firewall

General | Exceptions | Advanced 3

Windows Firewall iz blocking incoming network, connections, except for the
programs and services selected below. Adding exceptions allows some programs
to work, better but might increase wour security risk.

Programs and Services:

Mame ]
it Flemote 1/0 Port Mapper Utility
Agilent Remate 1/0 Server

[ File and Printer Sharing
LR s W ST TS .

Figure 2-2. 86100C SICL/LAN Programs

7 On the Windows Firewall, click the Advanced tab.
8 Click ICMP to open the ICMP Settings dialog box.

9 Clear or select Allow incoming echo request. Selecting this feature allows the Agilent
Connection Expert’s (version 15.0 and above) Instrument 1/0 on this PC to automatically find
the 86100C DCA.

ICMP Settings

Internet Control Meszage Pratocol [ICHP] allows the computers on
a network to share emor and status information. Select the requests
for infarmation fram the Intermet that this computer will regpond to:

Allow incoming echo request A
[ Allows incoming timestamp request =
[ Allows incoming mask request

. _‘_Igf‘lwgnliﬂg Tauter [ew

Figure 2-3. Allow Incoming Echo Request

25
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Step 4. Configure Agilent 10 Libraries Suite

Step 4. Configure Agilent 10 Libraries Suite

Install the Agilent 10 Libraries Suite on the PC.

On the PC, open the Agilent Connection Expert and locate the 86100C instrument device
address.

If communication is via the LAN, for the 86100C connection, note the TCPIPx value and
enter it in the spreadsheet’s 10 Port field for the DCA Setup. For example, enter TCPIPO.

In the Agilent Connection Expert, locate the Hostname for the 86100C connection. Enter
this string into the spreadsheet’s Address field for the DCA Setup.

After configuring the Agilent Connection Expert with the above steps, sending com-
mands to the instrument changes the instrument from local mode into remote mode,
which is similar to GPIB control. If, however, the device address inst0 is used instead of
gpib0,7 the instrument will not change from local to the remote mode and some dialog
boxes may be presented during the SICL/LAN session that require front-panel operation.

2-6
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Step 5. Install Applications on the PC

Step 5. Install Applications on the PC

¢ Run the downloaded file to install the application files on the PC. The default installation
creates the folder C:\Program Files\86100CU_400 as shown in the following figure. But, you can
install the application in another location if you want.

= j My Computer
= % Local Disk {C:)
=l |2) Program Files
= [5) 86100CU_400
|2 Compliance Application Setups
|2 Measurement. Results
|2 Measurement. Setups

o i b e A B, i 2

Figure 2-4. Installation Folders

The following workbook files are installed in the 86100CU_400 folder:

86100CU-400 PLL and Jitter Spectrum Measurement Application . .......... 86100CU_400_A.01.00.xIs
PClI Express (generation 1) . . ... ... .. . PCle_G1_A.01.00.xls
PCI Express (generation 2). . ... . PCle_G2_A.01.00.xls

NOTE The workbook applications can be installed on the 86100C, but it is recommended that you
use an external display that is connected to the 86100C.

2-7
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Step 6. Setup the Application

Step 6. Setup the Application

Start Microsoft Excel.
Click Tools > Add-Ins.
Select Analysis ToolPak and Analysis ToolPak - VBA.

Click File > Open and open the Jitter Transfer and Spectrum workbook,
86100CU_400_A.01.00.xIs

To configure and learn about the Jitter Transfer and Spectrum workbook, Chapter 3,
“Configuring the Workbook”.

2-8
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NOTE

Configuring the Workbook
Introduction

Introduction

The procedures in this chapter show you how to configure the essential settings. If you
want to learn more about these setting or about the settings not covered by these proce-
dures, refer to “Setup Entries” on page 5-2. For most measurement needs, you can use
the default values until you learn more about the individual settings and measurements.

To configure a workbook:

If you will perform general JTF, jitter spectrum, or jitter phase-noise measurements, refer
to “To Configure the PLL and Jitter Spectrum Workbook” on page 3-3.

If you will perform Jitter Transfer Function (JTF) compliance testing with one of the PCI
Express compliance workbooks, setup the compliance-specific workbooks as explained in
“To Configure the PCI Express Workbooks” on page 3-6.

The workbook files are installed in the 86100CU_400 folder:

86100CU-400 PLL and Jitter Spectrum Measurement Application. ........... 86100CU_400_A.01.00.xIs
PCI Express (generation 1) . ... ... ... . . PCle_G1_A.01.00.xls
PCI Express (generation 2) .. ... . . PCle_G2_A.01.00.xls
= _J My Computer
= % Local Disk {C:)
=l |2) Program Files

= [5) 86100CU_400
|2 Compliance Application Setups
|2 Measurement. Results

|2 Measurement. Setups
g B T b A BT R S T

Figure 3-1. Installation Folders

When you use one of the compliance-specific workbooks, the workbook’s setup entries are
automatically copied to the PLL and Jitter Spectrum Measurement workbook. This action
overwrites all of the settings in the PLL and Jitter Spectrum Measurement workbook.

3-2
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Configuring the Workbook

To Configure the PLL and Jitter Spectrum Workbook

To Configure the PLL and Jitter Spectrum Workbook

When you are configuring a the workbook,

the Setup worksheet includes a red triangle 2.500E+8" |Enter the data rate of the signal here.
. . . S0.0E+3 |Ifthe signal is a clock enter bwo times the
in the corner of an entry field. These triangles DIF P clock frequency.

indicate the presence of a comment. Com-

DataRate

ments provide information on the purpose of =™ gr s e g atemon b st

the field. Place the cursor over the cell to
enable the comment; do not click the mouse.

1 Open the PLL and Jitter Spectrum Measurement workbook (86100CU_400_A.01.00.xls). The
default location for this workbook is C:\Program Files\86100CU_400. Notice that the Setup

worksheet is displayed as shown in Figure 3-2.

B3 Microsoft Excel - B6100C_400_A.01.00.xs =)
DCA Setup 1
10 Port GFPIR o . -
Address i ~<: Agilent Technologies
Clock Recaovery Location 7] Dl i
Source Setup Jitter Saurce.  Clack Source  Data Source
| el GPIEL] GRIE] GPIEY 86100CU-400 PLL and Jitter Spectrum
Address 14 14 14 S
— Measurement Application
Clock Recovery Setup
Data Rate 5.000E+5 N
Loop Bandwicth 1000643 ) _ Save Sellyp:
Input CIFFY
Measurement Setup acall Setup
Canfiguralion 1 10 i} atall s
Measure Loop 1 k)
Dafault Chart ) - i
Spectrum g 101 1 Save Results
Jitter Transfer Setup d 15 2 pE—
Jitter Source 200 0E+T 0 0E+H] 015" b
Clock Source g 5000545 ) 0
Data Saurce Levels i 07 07
Data Source Patterns 1Y pros? upsld"
Revision 1.01.23
Fost Processing i Laft Module 61084
Frequency Filter PLL1 FLL2 Difference Right Module BE10EA
20E+ 35E +6) e I0E+] Jitter Source N4B03A
10.00E+3 NE+H | 0nE+S (A=) Clock Source N4B0EA
1 BOE+E" 0EAT 1 00+ Data Source  NASDRA
W 4 v W Setup Jitter Spectrum f Time Comain £ Jitter Trarsfer f Data / DataBw /' |« 5]

Figure 3-2. Workbook's Setup Worksheet

2 If you are using a LAN for communications with the test equipment, open the Agilent
Connection Expert application. Use it to locate the test equipment LAN port and 86100C

host name strings.

3 In the PLL and Jitter Spectrum Measurement workbook,

click the Setup worksheet tab.

3-3



Configuring the Workbook
To Configure the PLL and Jitter Spectrum Workhook
4 In the DCA Setup area, locate the 10 Port field.

¢ If you are using GPIB, enter the string GPIB followed by the port number. For example,
enter GPIBO.

¢ Ifusing a LAN, enter the string TCPIP followed by the PC’s LAN port number that is used
to identify the network connection used for the test equipment. For example, TCPIPO.

IO Port DCA Setup v
I0 Port GPIBC" "
Address Address 7
Clock Recovery Location T
Clock Recovery Source Setup Jitter Source ‘Clock Source ‘Data Source .
Location 10 Port GF'IEIJ‘ GF'IEIJ‘ GPIBD
Address 19 19 17

o pmn B e et anh ke B o Bt e S P i e e

Figure 3-3. DCA Setup Area

5 Locate the Address field.
e [fyou are using GPIB, enter the GPIB address of the 86100C. For example, enter 7.

e [fusing a LAN, copy the 86100C host name string (located in the Agilent Connection
Expert window) and paste it into the Address field.

6 Concerning the Clock Recovery Location field, the workbook application automatically
locates the clock recovery module and you do not need to enter a value into this field.
However, if there are clock recovery modules installed in both 86100C mainframe slots,
you can specify which module to use. Enter 1 if the module is in the left slot and enter 3 if
the module is in the right slot.

7 In the Source Setup area, locate the 10 Port field. The Source Setup area includes entries
for the Jitter Source, Clock Source, and Data Source.

DCA Setup

|0 Port GPIED"

Address 7

Clock Recovery Location 1

Source Setup Jitter Source  Clock Source  Data Source

1O Port - 10 Port GFIBC' GPIED' GPIED'
Address 19! ) 17"
© an I st ot A AAREE B n BN - =
IO Address - » Data Source Setup

Clock Source Setup
Jitter Source Setup

Figure 3-4. Source Setup Area

8 For each instrument type field, enter the GPIB or LAN port number.

9 In the Address fields for each instrument type, enter the GPIB address or LAN host name.
Depending on the test equipment that you use, these fields may represent the same
instrument.

10 Inthe Clock Recovery Setup area, locate the Data Rate field, enter the signal’s data rate. For
example, 10.000E+9 for 10 Gb/s. If the signal is a clock, enter two times the clock
frequency.

3-4
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Configuring the Workbook
To Configure the PLL and Jitter Spectrum Workbook

Loop Bandwidth

Clock Rw
Data Rate 2 500E+5"

Data Rate 50.0E+F 0
Input DIFF
/ M—_‘-\ — ‘w.‘%“
Input

Figure 3-5. Clock Recovery Setup Area

In the Loop Bandwidth field, enter the desired loop bandwidth setting for the clock recovery
module. For example, 8.0E+6 (8.0 MHz). For best sensitivity use the lowest loop
bandwidth setting that maintains lock with your signal.

In the Input field, enter one of the following strings to specify the input signal type at the
clock recovery input.

Signal Type Entry String
Datainput:. ... o ELEC
Data NPUL: . EINV
Differential INPUL:. . ..o DIFF
Optical input (if supported):. ... ... OPT

Because running a compliance-specific workbook, overwrites the configuration settings in
this workbook to known standards, always click Save Setups to save your entries. The
default location for saved setup files is C:\Program Files\86100CU_400\Measurement Setups.

35
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Configuring the Workbook

To Configure the PCI Express Workbooks

To Configure the PCI Express Workbooks

Open one of the compliance-specific workbooks which, by default, are located in the
C:\Program Files\86100CU_400 folder. The workbooks have the following file names:

e PCle_G1_A.01.00.xIs for PCI Express (generation 1) measurements
e PCle_G2_A.01.00.xIs for PCI Express (generation 2) measurements

Click on the Settings worksheet tab to display the worksheet as shown in Figure 3-2. The
left-side entries are for configuring the measurement settings. The right-side entries are
for configuring the settings used during calibrations. Normally, the DCA Setup and Source
Setup communication entries should be identical between the measurement and the

calibration settings. Because the device-under-test may employ frequency multiplication,
measurement and calibration setups are separated.

B Microsoft Excel - PCle_G1_A.07.00.xls

litter_B3496_L01.23.xlsh

TCPIPO|

Clock Recovery L

sveseup |

Recall Setup

AGILE NT-SAASC‘QF.sul:n.sgilsnt cam
i

calibrats sattings
DCA Setup

15 Port

Address

Clock Recovery L

TCRIFG|

AGILENT-SAA5C2F snca. agilent com

3

Source Semp  Jifter Saurce Clock Source Data Source Seurce Setup  Jnter Source Clock Seurca  Dala Source
GPIBD GPIED GFIED 10 Pan GRIEG) GPIEC) GPIEC
16 19 17 Addrese 19] 19| 17
Clock Racovery Setup Clack Recavery Setup
2500845 DataRate 2.500-3'
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Figure 3-6. Workbook's Settings Worksheet

Click Recall Setup. From the application’s /86100CU_400/Compliance Application

Setups folder, recall the setup file that is based on your jitter source

instrument:

¢ N4903A High-Performance Serial BERT: recall the file PCle_G1_N4903A.

Settings for
Calibration

Recall Setup

¢ 81150A Pulse Function Arbitrary Noise Generator: recall the file PCle_G1_81150A.

If you are using a LAN for communications with the test equipment, open the Agilent
Connection Expert application. Use it to locate the test equipment LAN port and 86100C
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host name strings.
5 Return to the workbook’s the Settings worksheet.
6 In the DCA Setup area, locate the 10 Port field.

¢ If you are using GPIB, enter the string GPIB followed by the port number. For example,
enter GPIBO.

¢ Ifusing a LAN, enter the string TCPIP followed by the PC’s LAN port number that is used
to identify the network connection used for the test equipment. For example, TCPIPO.

IO Port

DCA Setup v
I0 Port GPIBC" "
Address Address 7
Clock Recovery Location T
Clock Recovery Source Setup Jitter Source ‘Clock Source ‘Data Source .
: 10 Port GPIBO GPIBD GPIBD
Location 7

Address 1 1
R M--MMWM“-M‘ e

Figure 3-7. DCA Setup Area

7 Locate the Address field.
e [fyou are using GPIB, enter the GPIB address of the 86100C. For example, enter 7.

e [fusing a LAN, copy the 86100C host name string (located in the Agilent Connection
Expert window) and paste it into the Address field.

8 Concerning the Clock Recovery Location field, the workbook application automatically
locates the clock recovery module and you do not need to enter a value into this field.
However, if there are clock recovery modules installed in both 86100C mainframe slots,
you can specify which module to use. Enter 1 if the module is in the left slot and enter 3 if
the module is in the right slot.

9 In the Source Setup area, locate the 10 Port field. The Source Setup area includes entries
for the Jitter Source, Clock Source, and Data Source.

DCA Setup

|0 Port GPIED"

Address 7

Clock Recovery Location 1

Source Setup Jitter Source  Clock Source  Data Source

1O Port - 10 Port GFIBC' GPIED' GRIE0
Address 19! )
+ RNl s e o i AR, - sl g i s,
IO Address - » Data Source Setup

Clock Source Setup
Jitter Source Setup

Figure 3-8. Source Setup Area

10 For each instrument type field, enter the GPIB or LAN port number.

11 Inthe Address fields for each instrument type, enter the GPIB address or LAN host name.
Depending on the test equipment that you use, these fields may represent the same
instrument.
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Loop Bandwidth

Clock RW
Data Rate 2 500E+5"

Data Rate 50.0E+F 0
Input DIFF
/M_‘\ww.m“
Input

Figure 3-9. Clock Recovery Setup Area

12 Click Save Setup to save your entries. The default location for saved setup
Save Se
files is C:\Program Files\86100CU_400\Measurement Setups. Give your filename a w
unique name. Do not overwrite any of the default files.
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Introduction

Introduction

This chapter shows you how to make measurements using the workbooks. Before making
a measurement, you must configure the workbook as described in Chapter 3, “Configur-
ing the Workbook”. While a workbook is performing a measurement, the 86100C is in
remote mode and will not respond to front-panel control unless you press the 86100C’s
front-panel LOCAL key.

NOTE For a technical review of the importance of these measurements as well as insights into
the root causes of jitter, refer to Agilent Product Note 86100C-2 “Solving Jitter Problems
Through Jitter Spectrum and Phase Noise Analysis”.
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If the device that you are testing requires the same data rate for its input and output,
refer to “To Make a Measurement” on page 4-4.

If you are testing a frequency multiplying device such as a 2.5 Gb/s transmitter that
requires a 100 MHz clock and you are using a pattern generator for the source, refer to
“To Measure a Frequency Multiplying Device” on page 4-7 for important calibration infor-
mation. If you are using a simple clock source, refer to “To Make a Jitter Transfer Func-
tion Measurement” on page 4-16.

Several setup files are provided to help you to quickly configure your measurements.
Look in the Compliance Application Setups folder shown in the following figure. Two files are
for use with the PCI Express (generation 1) workbook (PCle_G1_A.01.00.xls):

e PCle_GI_81150A xIs configures the workbook for use with an 81150A function generator.
o PCle_GI_N4903Axls configures the workbook for use with an N4903A BERT.

Two files are for use with the PCI Express (generation 2) workbook (PCle_G2_A.01.00.xls):

¢ PCle_G2_81150A.xIs configures the workbook for use with an 81150A function generator.
¢ PCle_G2_N4903A.xIs configures the workbook for use with an N4903A BERT.

To configure the workbook with these setups, open the Settings worksheet
and click Recall Setup. Recall Setup

= [5) 86100CU_400 =] 25hsubRateClack,phrn
|2 Compliance Application Setups S0bSubRateClock, phrn
|2) Measurement Results Compliance. ptrn
|2) Measurement Setups IE_]PCIe_Gl_SUSDA.xIs

Epcre_c1_n4a034.x0s
Epcre_cz_s11506.xk
Epcre_cz_n4a034.x0s

Figure 4-1. Compliance Application Setup Files

Three pattern files (*.ptrn) are provided in the Compliance Application Setups folder: a compli-
ance pattern, a 2.5 Gb/s sub-rate clock pattern, and a 5.0 Gb/s sub-rate clock pattern.
These patterns can be used when testing a frequency multiplying device as described in
“To Measure a Frequency Multiplying Device” on page 4-7. Copy these pattern files into
the N4903A’s ¢:\N4903A\patterns folder. Then, in the workbook’s Data Source Patterns area of
the Settings worksheet refer to the pattern using the string:

fil,"c:\N4903A\patterns\<filename>"
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To Make a Measurement

1 Connect the source instrument directly to the 86100C. Do not connect the DUT at this
time. Figure 4-2 shows the connection if you are using an N4903A. If you using separate
jitter and data sources, connect the equipment as shown in the example of Figure 4-3.
Connect the source’s output signal to the appropriate on the 86100C clock recovery input
as described in “Clock Recovery Inputs” on page 4-12.

N4903A 86100C

— ooo

2228 0
oo

0 0000

o0 v o

{ 000000

co0o

o <] [+]
Sooooocooa] ® °9]°

DATA OUT | | DATA OUT CH1/CDR- | | CH2/CDR+

o0

ol

o0

Figure 4-2. N4903A Connected to the 86100C

33250A

81142A DELAY CTRL IN 86100C
——— oo I:I L 1 I
§ cdoooo EZE 0
=| °C0 ‘L:J, o o C
oy
20000000 |' 5000 o |
N —
DATA OUT | | DATA QUT CH1/CDR- CH2/CDR+

Figure 4-3. Alternate Setup Using Separate Data and Jitter Sources

2 Lock the clock recovery of the 86100C on the signal using one of two methods:
e Lock the clock recovery manually from the 86100C’s front panel.

¢ Lock the clock recovery from within the workbook. These settings override any manual
settings made from the 86100C front panel. In the workbook, view the Setup worksheet
and locate the Clock Recovery Setup entry fields: Data Rate, Loop Bandwidth, Input,
and Loop Peaking (86108A) fields. The workbook application performs a lock sequence
on the test signal when you initiate a measurement or calibration. To locally control the
86100C again, you must press the 86100C front-panel LOCAL key.
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If a module is installed in the 86100C that provides a receiver channel (for example, an
86112A), manually verify the quality of the input signal. Poorly defined waveforms may
prevent the ability to measure the signal.

Open the workbook, if not already opened. If prompted, enable any workbook macros.

5 On the Setup worksheet, configure the Measurement Setup fields. Refer to “Measurement

10

11

12
13

Setup” on page 5-6.

On the Setup worksheet, configure the Jitter Transfer Setup fields. Refer to “Jitter
Transfer Setup” on page 5-9.

In the workbook, open the Results worksheet.

Click the Calibrate button.

Calibrate

Connect the DUT in the test setup.

N4903A 86100C
—— ooo C— [ J
DATA OUT | | DATA OUT CH1/CDR- CH2/CDR+
DUT
IN ouT

Figure 4-4. Example Equipment Setup with the DUT Connected

In the workbook, click Run.

Run

When the measurement completes, the pass/fail status is displayed near the top of the
worksheet.

View the measurement results chart that is located at the bottom of the worksheet.

Click the Calculate Model button. A third-order type-2 PPL model is calculated from the
data and displayed in the chart as shown in Figure 4-15. Notice that the model's f | fgam,

and fwm values are also listed on the chart. This software model may be used in your
simulation programs. The Observed Jitter Transfer Function (OJTF) is also displayed.

Calculate Model
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i AgilentTechnologies L

Frequency Hz)

Figure 4-5. JTF Measurement Results
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Example

Jitter Transfer S
Jitter Source
Clock Source
Data Source Leve
Data Source Patt

To Measure a Frequency Multiplying Device

Calibrations for Jitter Transfer Function measurements subtract the effects of test-sys-
tem non-linearity effects (flatness) from the measurement results. Both the source and
the receiver can contribute to an unflat response. If a device such as a transmitter
employs clock multiplying, the data rate must be different between system calibration
and the measurement. Change the data rate affects system response and results in a less
accurate calibration. However, if you change the data pattern (to mimic a lower data rate)
instead of the actual data rate, as described in this section, very accurate calibrations can
be performed. This is because the source’s jitter performance varies little with changes in
pattern.

Consider a transmitter that requires a 100 MHz clock but has an output at 2.5 Gb/s. The
calibration for system flatness should be done with the source set to a 2.5 Gb/s data rate
with a PRBS pattern, since this is the output data rate of the transmitter. However, the
measurement with the transmitter requires a 100 MHz input for the device. A 25-bit pat-
tern (13 ones followed by 12 zeros) is created so that it mimics a 100 MHz clock during
the measurement:

2.5 Gb/s data rate

= 25 bit L
100 MHz clock v pattern

Create a user data pattern with 13 ones followed by 12 zeros and store it in the source

instrument. In Figure 4-6 the pattern is named upat3. (If the pattern is not in the source’s
default folder, you will need to refer to it in the workbook’s Data Source Pattern field using
a string such as fil," mypatternfile”. This pattern will appear to the DUT as a 100 MHz clock.

1111111111111000000000000

In the PCI Express workbook, open the Settings worksheet and enter the patterns used
for both measurement and calibration. Select the source’s pattern to be identical to that
which the DUT produces at a 2.5 Gb/s data rate. A PRBS pattern usually works well.

Run Settings Calibrate Settings
B S Ot S S S
o | 20 Jitter Transfer S
3 3 " Jitter Source
0 2.500E+9 3 Clock Source
r 07 0.7 Data Source Leve
r ) " Data Source Patt

B e L o S TUR L N F R P - oy s TN e I 0T, i e Al b T T S nh A e B e e e

Calibration
Pattern

Measurement
User Pattern

Calibration
Pattern

Measurement
User Pattern

Figure 4-6. Example Pattern Settings

4-7



Making Measurements
PCI Express Workbooks

3 Perform the calibration without the DUT.

N4903A 86100C
1 pao —— loee =

e]

frii=ipeiy e s
S oo

0 00090
0000ca

coDo

2obooooci] © @
DATAOUT | | DATAQUT CH1/CDR- CH2/CDR+

—— 2.5Gb/s PRBS ——
Figure 4-7. Calibration Automatically Uses Specified Calibration Pattern

4 Connect the DUT in the test setup and perform the measurement.

N4903A 86100C
ooo __o

B ootoaoil o o
(=00 00 o -
DATAQUT | | DATAOUT CH1/CDR- CH2/CDR+
DUT
IN ouT
— 25GCGbls — — 25GCGb/s —

1111111111111000000000000
pattern mimics 100 MHz clock

Figure 4-8. Measurement Automatically Uses Specified Mimic Pattern

If the DUT’s output is at 5 Gb/s, in the above steps you would set the data rate to 5 Gb/s
and during the measurement change to a pattern of 25 ones followed by 25 zeros:

11111111111111111111111110000000000000000000000000
NOTE Example pattern files are provided for both 2.5 Gb/s and 5.0 Gb/s sub-rate clock patterns.

These files can be installed on your N4903A and reference within the workbook. Refer to
“Example Pattern Files” on page 4-3.
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Example

To Measure a Frequency Multiplying Device Using a Clock Source

When a clock source is used instead of a pattern generator for measuring a frequency
multiplying device, it is not possible to use a mimic pattern as described in “To Measure a
Frequency Multiplying Device” on page 4-7. The data rate employed for the calibration
and the measurement must be different. The calibration will still eliminate the majority of
the non-flat system response, but the receiver response between the data rates used will
affect the measurement.

For a transmitter that requires a 100 MHz clock but has an output at 2.5 Gb/s, the PCI
Express workbook must be configured to use both of these data rates. During calibration,
the 86100C interprets the 100 Mb/s data rate as a 200 Mb/s 10101010 data stream.

Connect the clock source directly to the 86100C.
Lock the clock recovery of the 86100C on the signal using one of two methods:
e Lock the clock recovery manually from the 86100C’s front panel.

e Lock the clock recovery from within the workbook. These settings override any manual
settings made from the 86100C front panel. In the workbook, view the Setup worksheet
and locate the Clock Recovery Setup entry fields: Data Rate, Loop Bandwidth, Input,
and Loop Peaking (86108A) fields. The workbook application performs a lock sequence
on the test signal when you initiate a measurement or calibration. To locally control the
86100C again, you must press the 86100C front-panel LOCAL key.

If a module is installed in the 86100C that provides a receiver channel (for example, an
86112A), manually verify the quality of the input signal. Poorly defined waveforms may
prevent the ability to measure the signal.

Open the PCI Express workbook, if not already opened. If prompted, enable any workbook
macros.

Open the Settings worksheet and enter the setting shown in Figure 4-9 on page 4-10. Make
sure that all other setting meet your measurement requirements.

In the workbook, open the Results worksheet.

Click the Calibrate button.

Calibrate

8 Connect the DUT in the test setup.

10

11

In the workbook, click Run.

Run

When the measurement completes, the pass/fail status is displayed near the top of the
worksheet.

View the measurement results chart that is located at the bottom of the worksheet.
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2.5 Gb/s 200 Mb/s
Receiver Receiver
Run Setting Calibration

Setting
100 Mb/s 100 Mb/s
Clock Clock
Run Setting Calibration
Setting

2.00E+6 3REEHS 2.00E+6 3BEEAS
10.00E+3 [E o | D0E+d] 000 00F-+0)] 10,0063 4 HEE

L50E+6 1 (E+4 1 oce+0 LSO+ [
e

Figure 4-9. Example Data Rate Settings
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PLL and Jitter Spectrum Measurement Workbook

After making a measurement, click on the worksheets to view the measurement results.
Most of the worksheets are always available. However, the following worksheets are dis-
played based on worksheet settings:

e The Jitter Transfer worksheet is not displayed until a JTM measurement is made as ex-
plained in “To Make a Jitter Transfer Function Measurement” on page 4-16.

e The Histogram worksheet is not displayed unless post-processing is activated as explained
in “Post Processing” on page 5-11.

e dataBW worksheet is not displayed unless the Loop Response On/Off field is switched on as
described in “Loop Response On/Off” on page 5-7.

BT Microsoft Fxcel - B6100C_400_A.01.00.xls

10 Port GPIB eghe - =
Al ” 2% Agilent Technologies
Clock Recovery Location ™ = TS
Charts of Post- Source Setup Jitter Source Clock Source  Data Source
Processed Data ol GRel  oRo  ehed 86100CU-400 PLL and Jitter Spectrum
Measurement Application
Clock Recovery Setup -
i 100.0E+ - 75}”5@
Jitter vs Time Chart [
Freq. vs Time Chart b Rewsl Sehm:
1 Save Resulls
. 20
Jitter Spectrum and GEL Help
Phase Noise Charts o7 =
upant"
Revision 1.01.23
Left Module BE10BA
Oifferance Right Modula BE108A
(0E +0} Jitter Snurce h4SEA
000.00E + 0} Clock Source MAS0Z4
Data Source h4S03A
w4+ b\Setup / Jtter Spectrum { Time Daman  Hstogram { Mtter Transfer ( Data { DataBw { DatalTF /-
JTF Chart Jitter Spectrum and Step Response JTF Data

and Table Phase Noise Data Data

Figure 4-10. Measurement Result Worksheets
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Measure
Jitter Transfer

Yerify Calibration

1 0§

Calibrate
Jitter Transfer

Save Setup

Recall Setup

Save Results

Help

Click to initiate a jitter spectrum and phase noise measurement on
your device-under-test. Refer to “To Make a Jitter Spectrum and Phase
Noise Measurement” on page 4-14.

Click to measure the Jitter Transfer Function (JTF) using your device-
under-test. The first time that this measurement is performed or
whenever the measurement is reconfigured, click Calibrate Jitter Trans-
fer before making the measurement. Refer to “To Make a Jitter Trans-
fer Function Measurement” on page 4-16.

Click to view the calibration data for a JTF measurement. This is used
to confirm that the calibration data is valid.

Use this feature to calibrate a JTF measurement. Connect the source
directly to the 86100C without the DUT and then click this button.
After the calibration, connect the device-under-test in the test setup
and then click Measure Jitter Transfer.

Click to save and recall all of your configuration settings to a spread-
sheet file. The settings file is saved in the following default sub-folder:

C:\Program Files\86100CU_400\Measurement Setups

You can always return the workbook application to its original configu-
ration settings by recalling the default.xls file.

Click to save your measurement results in a new workbook file. The
new file is then closed, and the original workbook is reopened.

The following is the default folder for saving the file:
C:\Program Files\86100CU_400\Measurement Results

Click to view the user’s guide (this book) in PDF format. The help file
must be in the current working folder for it to be found. With normal
installation, this is the C:\Program Files\86100CU_400\ folder.

Consider the following when connecting the DUT’s output signal to the appropriate clock
recovery input on the 86100C:

e For single ended electrical signals, connect the signal to the DATA+, DATA—- inputs on the
83496B module or the CDR+, or CDR— inputs on the 86108A module.

e For differential electrical signals, connect both DATA+ and DATA- inputs on the 83496B.
Or, the CDR+ and CDR- inputs on the 86108A.

e For single-mode optical signals (1250 nm to 1620 nm), use 9/125 um input fiber. Optical
signals require an 83496B-101.

¢ For multimode optical signals (780 nm to 1330 nm), use 62.5/125 um input fiber. Opti-
cal signals require an 83496B-101.

When measuring a clock, the clock-recovery modules regard the clock as a data signal. A
clock signal with a 101010 data pattern is perceived to have a rate that is double the clock
rate. So, for clock signals, always enter a data rate that is twice the clock rate. For exam-
ple, for a typical 100 MHz PCI Express reference clock, enter 200 Mb/s. As a result, the
measurable range of clock frequencies is half the range of measurable data rates. For
example, when using an 83496B Option 200 (data rate range of 50 Mb/s to 13.5 Gb/s), the
effective clock rate range that can be tested is 25 MHz to 6.75 GHz.
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Loop Bandwidth. When setting the loop bandwidth, enter the minimum value, since the
narrowest loop bandwidth setting results in the lowest noise. If you enter 1 kHz the
86100C automatically selects the narrowest loop bandwidth setting available at the data
rate you have chosen. If the 86100C fails to lock to the input signal, increase the loop
bandwidth setting. If lock still fails, enter the maximum loop bandwidth setting for the
data rate . Enter 10 MHz and the 86100C automatically selects the widest loop bandwidth
setting available at the data rate. If lock is established, reduce the loop bandwidth until
lock occurs at the narrowest loop bandwidth setting possible. If lock still fails, the prob-
lem is likely independent of the loop bandwidth.

Injected Step Function. The spreadsheet application injects a step function into the loop in
order to characterize its own loop dynamics. It is possible that in some circumstances
injecting that small step can cause the loop to fall out of lock. If that happens, increasing
the loop bandwidth by 10% should correct the problem.

The signal must be within the data rate range supported by the clock recovery module:

BBT108A . . 50 Mb/s to 13.5 Gb/s
83496B standard . ... ... ... 50 Mb/s to 7.1 Gb/s
83496B Option 200. . .. ... .o 50 Mb/s to 13.5 Gb/s
83496B Option 2071, . ... ... 7.1 Gb/st0 13.5 Gb/s

If the 86 100CU-400 PLL and Jitter Spectrum Measurement Application stops
responding during operation, press the Escape key.
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To Make a Jitter Spectrum and Phase Noise Measurement

The default frequency band for the measurement is between 10 kHz and 1.5 MHz. To
change this range, refer to “Frequency 1 and 2” on page 5-12. view the Setup worksheet
and enter new Frequency 1 and Frequency 2 values . Post processing does not need to be
enabled as these values are always used when measuring jitter spectrum and phase noise.

Connect the device-under-test (DUT) to the 86100C as shown in Figure 4-11. A source is
not used. Connect the DUT’s output signal to the appropriate on the 86100C clock
recovery input as described “Clock Recovery Inputs” on page 4-12.

86100C

CH1/CDR- CH2/CDR+

DUT

DATA OUT

DATA OUT

Figure 4-11. Example of Test Equipment Setup with a Differential Electrical Signal

Lock the clock recovery of the 86100C on the signal from the DUT using one of two
methods:

e Lock the clock recovery manually from the 86100C’s front panel.

e Lock the clock recovery from within the workbook. These settings override any manual
settings made from the 86100C front panel. In the workbook, view the Setup worksheet
and locate the Clock Recovery Setup entry fields: Data Rate, Loop Bandwidth, Input,
and Loop Peaking (86108A) fields. The workbook application performs a lock sequence
on the test signal when you initiate a measurement. To locally control the 86100C again,
you must press the 86100C front-panel LOCAL key.

If a module is installed in the 86100C that provides a receiver channel (for example, an
86112A), manually verify the quality of the input signal. Poorly defined waveforms may
prevent the ability to measure the signal.

Open the workbook, if not already opened. If prompted, enable any workbook macros.

5 On the Setup worksheet, configure the Measurement Setup fields. Refer to “Measurement
Setup” on page 5-6.

In the workbook, click the Measure Jitter Spectrum button.

Open the Jitter Spectrum worksheet and click Jitter Spectrum / Phase Noise to switch
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between viewing the jitter spectrum and phase noise charts.
Jitter Spectrurn /
Phase MNoise

8 Open the Time Domain worksheet to view charts showing Jitter-vs-Time and Frequency-
vs-Time.
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To Make a Jitter Transfer Function Measurement

1 Connect the source instrument directly to the 86100C. Do not connect the DUT at this
time. Figure 4-12 shows the connection if you are using an N4903A. If you using separate
jitter and data sources, connect the equipment as shown in the example of Figure 4-13.
Connect the source’s output signal to the appropriate on the 86100C clock recovery input
as described in “Clock Recovery Inputs” on page 4-12.

N4903A 86100C
——— ooo. —— L ]

22920

oa

o0 v o

0 0000

co0o

o o [+
Sooooocooa] ® °9]°

DATA OUT | | DATA OUT CH1/CDR- | | CH2/CDR+

o0
of
of

Figure 4-12. N4903A Connected to the 86100C

33250A

81142A DELAY CTRL IN 86100C
—— [=l=ls I:I C 1 I
§ odoooo 5::: o
o| o900 ‘L:J, o
20000000 |' 5000 o |
N —
DATA OUT | | DATA QUT CH1/CDR- CH2/CDR+

Figure 4-13. Alternate Setup Using Separate Data and Jitter Sources

2 Lock the clock recovery of the 86100C on the signal using one of two methods:
e Lock the clock recovery manually from the 86100C’s front panel.

e Lock the clock recovery from within the workbook. These settings override any manual
settings made from the 86100C front panel. In the workbook, view the Setup worksheet
and locate the Clock Recovery Setup entry fields: Data Rate, Loop Bandwidth, Input,
and Loop Peaking (86108A) fields. The workbook application performs a lock sequence
on the test signal when you initiate a measurement or calibration. To locally control the
86100C again, you must press the 86100C front-panel LOCAL key.
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If a module is installed in the 86100C that provides a receiver channel (for example, an
86112A), manually verify the quality of the input signal. Poorly defined waveforms may
prevent the ability to measure the signal.

Open the workbook, if not already opened. If prompted, enable any workbook macros.

5 On the Setup worksheet, configure the Measurement Setup fields. Refer to “Measurement

10

11

12

NOTE

13

Setup” on page 5-6.

On the Setup worksheet, configure the Jitter Transfer Setup fields. Refer to “Jitter
Transfer Setup” on page 5-9.

In the workbook, click the Calibrate Jitter Transfer button.

When the calibration is finished, click Verify Calibration. Open the DataJTF worksheet, and
confirm that the calibration data is linear indicating that it is valid.

v

Open the Setup worksheet.
Connect the DUT in the test setup.

N4903A 86100C
——— coo C—— L ]
::::_-:_::E_?::f-O

Boooooooa] © °4]e 55 o
DATA OUT | | DATA QUT CH1/CDR- CH2/CDR+
DUT
IN ouT

Figure 4-14. Example Equipment Setup with the DUT Connected

In the workbook, click Measure Jitter Transfer.

o

Open the Jitter Transfer worksheet to view the measurement results.

The Jitter Transfer and dataJTF worksheets are not displayed until a JTM measurement is
made.

Click the Calculate Model button. A third-order type-2 PPL model is calculated from the
data and displayed in the chart as shown in Figure 4-15. Notice that the model'sf  f

zero? ~gain’

and floole values are also listed on the chart. This software model may be used in your

4-17



Making Measurements
PLL and Jitter Spectrum Measurement Workbook

simulation programs. The Observed Jitter Transfer Function (OJTF) is also displayed.

£ Agilent Technologies - _
: mmaﬂmm Jitter Transfer Function / OJTF Model

| ____—— Measured JTF
Data Points

| __— JTF Model

Magnitude (dB)

Figure 4-15. JTF Measurement Results
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NOTE

Microsoft Excel - B6100C_400_A.01.00.xls

Jitter Spectrum Worksheet

The Jitter Spectrum worksheet displays charts of the input signal’s jitter spectrum and
phase noise. The jitter spectrum chart shows jitter (in seconds_ ) versus jitter frequency.
The jitter phase noise chart shows jitter power (dBc/Hz) relative to the total signal power
(normalized to a 1 Hz bandwidth) versus jitter frequency. Click the displayed Jitter Spec-
trum/Phase Noise button to switch between viewing the two charts. If you want to specify
which chart is shown in the initial view, refer to “Default Chart” on page 5-7.

If the Jitter Spectrum/Phase Noise button is not displayed, click on any spreadsheet cell.
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M 4 » My Setup ' Jitter Spectrum / Time Domain 4 Histogram / Jitter Transfer £ Data £ DataBw / DatalTF /

Deterministic Jitter

Total Jitter

Random Jitter

Figure 4-16. Example of the Jitter Spectrum Worksheet

Deterministic jitter is determined by taking the rms sum of all the spectral peaks of the
jitter spectrum. You can control the determination of a spectral peak, which can influence
this result. Refer to “Show Peak Markers” on page 5-8.

Total jitter is determined by performing an rms integration of the complete spectrum over
the integration limits defined by the user.

Random jitter is determined through integration of the jitter spectrum, with the spectral
tones removed, over three different bandwidths. The first is from the first filter frequency
to the maximum frequency of the measurement (either 2 MHz or 20 MHz, depending on
the sample rate setting). The second bandwidth is from second filter frequency to the
maximum frequency. The third bandwidth is the frequency range between the two filter
settings.
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Periodic jitter is displayed as discrete spectral lines. However, there can be spurious spec-
tral lines that are artifacts of the measurement process. The jitter spectrum and phase
noise measurement is not synchronized with the data pattern so it is possible that some
pattern effects can be seen in the measurement results.

When evaluating a data signal composed of an even-length repeating pattern it is possible
for a small spur at the frequency defined by

harmonic of sample rate — __data rate
pattern length

where data rate/ pattern length = pattern repetition rate

For odd length repeating patterns two small spurs can occur. One spur occurs when the
conditions for the above even-length repeating patterns equation is met. The other spur
occurs at the frequency defined by

data rate
2(pattern length)

harmonic of sample rate —

The following example show the possible spurs for an odd length repeating pattern (127
bits). Suppose that the measurement configuration employs the following conditions:

Data Rate: . ... 9.953 Gb/s
Sample Rate:. . .. 40 MHz
Frequency Measurement Window:. . ........ . ... . .. 3 kHz to 20 MHz
Pattern Length: ... ... .. . . 127 bits (odd)
Pattern Repetition Rate: . .......... .. . . . . . 78.4 MHz'!
Pattern Repetition/Z:. . .. ... o 39.2 MHz

Measurement spurs would be possible at 1.6 MHz:

80 MHz - 78.4 MHz = 1.6 MHz spur

and at 800 kHz:

= 800 kHz spur

20 Mis - (78. 42MH2)

. 78.4 MHz approximately equals 99.953 Gb/s divided by 127 bits.
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Time Domain Worksheet

This worksheet displays two charts: Jitter-vs-Time and Frequency-vs-Time.

‘% Agilent Technologies Titterve iTime
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% EE12 BE-12
=
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T 000E+D - 'm n U LW |'|l LW e L U L onevoc ¢
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200E+3
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000E+0 SE5 10E-6 15E6-6 20E-6 2566 30E-6 35E-6 40E-6 45E-6
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W 4 » MPy Setup f Jitter Spectrum Y, Time Domain / Jitter Transfer / Data / DataBw 4 DatalTF /
Figure 4-17. Example Time Domain Werksheet
Jitter vs Time Chart On the chart, the pink trace is the phase modulation seen at the input of the clock-recov-

ery module’s phase detector. This plot indicate how the clock-recovery module can track
jitter and remove it from a general waveform analysis. Thus the pink input phase error is
a measure of the total jitter observed by the clock-recovery module. Since phase is the
integral of frequency, if triangle shaped SSC frequency modulation were present, this dis-
play would be a parabolic shaped phase deviation. Viewing the input phase in the jitter
domain provides an important troubleshooting capability. If phase transients occur, for
example when a PLL loses synchronization or exceeds its allowable phase range, the
phase glitch can be observed directly in the pink input phase trace.

The blue phase error trace is an indication of the actual signal that the measurement sys-
tem is observing and the residual jitter not tracked by the clock-recovery module. It is
simply an indicator of how hard the clock-recovery module’s phase lock loop is working to
track the incoming signal. If the input phase and the phase error were similar, it would
indicate that the clock-recovery module’s phase lock loop is not tracking the input signal.
Note that the axes for the input phase error are orders of magnitude larger than the verti-
cal axis for the phase error.
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Jitter vs. Time
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Figure 4-18. Chart Showing Signal with SSC

The Frequency vs Time chart is generated by differentiating the measured phase. Since
frequency is the derivative of phase and differentiation can sometimes generate artificial
noise, you can apply the post-processing low-pass filter to smooth out this effect. Refer to
“Single Pole HPF Cutoff and Transport Delay” on page 5-13. The jitter spectrum can be
processed to determine random, deterministic, and total jitter. You can define the range
of the spectrum to be processed using two filter settings as explained in “Frequency 1
and 2” on page 5-12.

Agilent Technologies
DCA-J

Frequency vs Time Mean= 2.493789E+9

Picture 1
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Figure 4-19. Chart Showing Signal with SSC
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Jitter Transfer Worksheet

The Jitter Transfer worksheet displays the results of the Jitter Transfer Function mea-
surement. The chart shows the measured JTF data points along with a JTF model based
on these points. Clicking Calculate Model, displays an Observed Jitter Transfer Function
(OJTF) model which is a third-order type-2 PPL model that is based on the post-process-
ing high-pass filter. It indicates the jitter frequencies that will be transferred on the PLL
output signal. At the bottom of the worksheet, a table lists JTF and OJTF values.

This worksheet is not displayed until a JTF measurement is made.

% Agilent Technologies
B5100CU-400 PLL and Jitter Spectrum Jitter Transfer Function

Measurement Application / OJTF Model

s,

| ____—— Measured JTF
Data Points

| __— JTF Model

Magnitude (dB)
o

-20
=25
30
35
40

100E+3 1E+6 10E+6 100E+6
Frequency (Hz)

Jitter Transfer Function 3rd Order Model

Bandwidih (3 dB) 12.71E46 f_zer0 647 B3E+3

Peaking (dB) 0.59 f_gain B.EGE+S Calculate Modsl

Minimumn Point (d8 -12.38 f_pole 22B2E46

M 4 » w'\Setup { Jtter Spectrum / Trme Domain \Jitter Transfer { Data £ DataBW / DataITF /

Figure 4-20. Example of the Jitter Transfer Worksheet
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Histogram Worksheet

This worksheet displays the test signal as it would be observed having gone through post
processing. It is only available when post-processing is turned on. Refer to “Post Process-
ing” on page 5-11. Post processing allows the measured signal to be passed through two
virtual PLLs with a fixed transport delay between them. The loop bandwidths of the vir-
tual PLLs can clean up the jitter, but the clean up is affected by any time delay the signal
experiences traveling from one PLL to the other. There are two charts in this worksheet.
The Processed Signal Jitter chart shows the observed jitter, measured in seconds, as a
function of time. The Processed Signal Jitter Histogram chart shows the probability den-
sity, which is how often the signal reaches a given jitter magnitude. The pink traces of the
histograms represent the cumulative distribution functions for each half of the histogram.
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data Worksheet

This worksheet displays phase-error data from the clock-recovery module’s PLL phase
detector output. The presence of data on this worksheet confirms that the loop response
has been measured. There is no information relative to the signal being measured. Each
measurement is based on a sample-rate time record of 12288 points for the 83496B mod-
ule or 24576 points for the 86108A module. (Refer to “Sample Rate” on page 5-7 for the
different sample rates available.) Results are displayed as a function of time or trans-
formed to be displayed in the frequency domain (jitter). Because the loop response is
known, it is possible to remove its response as well as view the signal from the perspec-
tive of the input to the clock recovery module or the output of the internal phase detec-

tor.
A | B | C [ b [ E ] F [ G [ H ] I J
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| 24 | 27856 2.48E-07 - 16E-12) 20828.25 2397E-14 239746E-14 -103.539953 -4.27E-12 -4.99E+04
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Figure 4-21. Example of the data Worksheet
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dataBW Worksheet

This worksheet displays the measurement data of the loop response of the clock recovery
module while it is locked to the signal being measured. The chart shows the response to
internally generated step. The dataBW worksheet is not displayed unless the Loop
Response On/Off field is switched on as described in “Loop Response On/Off” on page 5-7.

The following chart is displayed on the worksheet. It shows the response of the clock
recovery module to the internally generated step (within the loop). The application uses
this response to back out the effects of the clock recovery module on the measured

results.
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Figure 4-22. Example of the dataBW Worksheet
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dataJTF Worksheet

The dataJTF worksheet is not displayed until a JTM measurement is made.
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Figure 4-23. Example of the dataJTF Worksheet
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Loop Response

Threshold

On / Off

-’r.,______,..--"‘

Capturing Transients

A well-behaved signal may occasionally have a significant phase-error component. For
example, this can occur whenever the phase detector in a clock multiplier circuit phase
wraps (phase exceeds + 7). This section describes how to evaluate the signal over a long
period of time and record the measurement only when the large phase error occurs.

You will need to adjust the Threshold and Number of Measurement settings that are shown
in Figure 4-24. The Loop Response On / Off setting can be used to reduce the test time. A
high Threshold setting when combined with a large Number of Measurements setting
results in a long test time.
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Figure 4-24. Entry Fields Used for Measuring Transients

The Threshold setting is the setting at which data is saved and recorded as expressed by
the following equation:

transient peak phase-error
(e}

threshold setting =

where o is the overall standard deviation of the phase error.

For example, a Threshold of 2, stops the measurement (captures the transient) when the
phase error is double the overall standard deviation. If the threshold is never met, the
measurement stops when the maximum Number of Measurements is reached. If this hap-
pens, decrease the threshold. If the system trips on signals other than the event that is
being sought, increase the threshold.

4-28



Number of

Measurements

Loop Response On / Off
1
2
3
4
5
6
7
8

CAUTION

Making Measurements
PLL and Jitter Spectrum Measurement Workbook

If the threshold is reached, the phase error chart shows the result of only the last mea-
surement (where the threshold was reached), while the phase noise and jitter spectrum
charts are averaged over all the measurements taken.

The Number of Measurements setting determines the maximum number of measure-
ments performed if a transient is not located as defined by the Threshold setting. Mea-
surements continue until either of the following events occur:

e a phase error meets the threshold or

¢ the maximum number of measurements is reached.

If you're an experienced user, you can decrease measurement time by turning this setting
off (enter 0). The default setting is on which causes the loop response to be measured
and allows the system to provide accurate results via loop-response compensation. For
situations where a large number of measurements is made, you can prevent the measure-

ment algorithm from taking the time to remeasure the loop response for every measure-
ment.

Configure all of your measurement settings so that you are ready to capture a transient.
Set the Number of Measurement setting to 1 (on).

Set the Loop Response On/Off to 1 (on).

Make a measurement.

Do not make any changes to data rate or the data pattern. The clock recovery module has
been locked to the signal being evaluated and a standard jitter spectrum and phase noise
measurement has been made. The workbook has evaluated and recorded the loop
response and further measurements of the loop are not required.

Increase the Number of Measurement setting to the desired value.
Set the Loop Response On/Off to 0 (off).
Make your measurement to search for a transient.

Return the Loop Response On/Off setting to 1 (on).

Be sure to return the Loop Response On/Off setting to 1 (on) or the accuracy of future
measurements may be compromised.
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Loop Response
On / Off

Loop Response On/Off

Number of
Measurements

Threshold

Averaging the Measurement in the Frequency Domain

To minimize noise in the frequency response plots, configure the measurement to average
in the frequency domain (the phase error in the time domain will not be averaged). Con-
figure the following parameters in the Setup worksheet.

EI Microsoft Excel - B6100C_400_A.01,00.xIs
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Enter a 1 to specify that the loop response is measured.This parameter determines if the
clock recovery module’s loop response (as locked to the signal being evaluated) will be

measured.

Set the parameter to the number of averages desired.

Threshold sets the phase error threshold to trigger the saving data process and records a
jitter spectrum or phase noise measurement. Set to a large number, for example 100, this
state is likely never reached, allowing the desired number of averages to be completed
before the data is recorded and processed.
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Measuring Signals Below 50 Mb/s

Because the minimum data rate supported by the 83496B and 86108A modules is

50 Mb/s, the minimum data rate supported by the application is 50 Mb/s (or a 25 MHz
clock). However, depending on your data pattern, you may be able to lock the clock
recovery module to a slower data or clock rate.

For example, a 1011001 pattern at 25 Mb/s looks just like a 11001111000011 pattern at
50 Mb/s. A clock signal is just a special case where the pattern is a repeating 101010. If
you have a signal you need to evaluate that is below the minimum 50 Mb/s rate, try lock-
ing the clock recovery module by configuring the module as to a signal that is 2, 3 or 4
times faster than the actual data rate. The clock recovery circuit then considers each bit
in the pattern to be 2, 3, or 4 consecutive identical bits. Provided the clock recovery mod-
ule can lock to the signal, the jitter spectrum and phase noise measurement results will
not be affected by this approach.

Verifying System Operation

As long as the 834968 is capable of locking onto the signal being tested, the workbook
application should provide good measurement results. The workbook application per-
forms best with narrow loop bandwidth settings for the clock-recovery module. However,
complicated signals may require the module to be set to a wider loop bandwidth to
achieve lock. Use the lowest loop bandwidth for which a lock condition can be achieved.

Verification of operation can be achieved by measuring a high quality signal generator
that is producing a simple clock or sinusoid. Use of a high quality generator should yield a
signal with low jitter spectrum noise (and low phase noise) providing an indication of the
system’s ability to observe low-jitter signals. Some examples of signal generators that
might be used include the Agilent 8257D or 8267D. Any generator capable of producing a
clock-like signal at GHz frequencies will work. Although signals with reduced spectral
purity result in higher jitter noise results, the basic system operation can still be con-
firmed. The ability to also produce a specific level of periodic jitter at a specific frequency
will also help verify system operation.

In the following example, a 2.5 GHz clock signal from an Agilent 8267D is measured. The
Signal Studio software application is used to generate 0.1 Ul of periodic jitter at 1.2 MHz.

The following is the workbook configuration:

Datarate:.................... ... ..., 5 x 10 ® (double the frequency when measuring a clock)
LoOp BV . 100000
IMpUL: L ELEC (single-ended clock-recover input)

The 8267D has extremely low phase noise, thus the jitter spectrum is quite low, under

1 fs above 300 kHz. The periodic jitter is seen as several tones, with the dominant tone at
1.2 MHz. There are also tones at 2.4 MHz and 3.6 MHz. These represent harmonic distor-
tion components of the desired 1.2 MHz periodic jitter.

Notice that the harmonic distortion components are several orders of magnitude smaller
than the main tone (the y-axis is logarithmic). The very low phase noise of the source
allows the distortion tones to be observed. More common digital communications signals
often have jitter noise that would completely obscure these tones. In addition to the

1.2 MHz series of tones, there are also tones at approximately 950, 1900, and 2850 kHz.
These tones originate from the switching power supply in the 83496B. Again, the ultra
low jitter of the 8267D source allows these spurious tones to be observed.
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The best way to gauge the magnitude of the random jitter, represented by the noise floor
of the jitter spectrum, is to integrate it over a specific bandwidth. The maximum fre-
quency range of the application is 20 MHz. Results will depend on the quality of the

source and the precision to which periodic jitter can be produced. As noisier sources are
used, the integrated jitter spectrum will be larger.
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Setup Entries

This section describes each setup entry field. When using the application, move the cur-
sor over the red triangle on each field to view a comment.

DCA Setup

DCA and Source Setup

DCA Setup

Source Setup

_—
7

ES Microsoft Excel - B6100C_400_A.01.00.xls

GPIB0'
7
Clack Recovery Location 1
Source Setup Jitter Source  Clock Source  Data Source
10 Port GPIBD) GPIED GPIBC
Address 14 141 14
Clock Recovery Setup
Data Rate 5.000E+9)
Loop Bandwidth 100.0E+3' 1)
Input DIFF'
Measurement Setup
Configuration 1 100 1)
Measure Loop 1 k)
Default Chart g|
Spectrum g 100 1
Jitter Transfer Setup i) 15 20
Jitter Source 200 0E+3) 300E45 0.15"
Clock Source i) 5.000E+9" )
Data Source Levels 1 0.7 0.7
Data Source Pattems 1 pros? upatd"
Past Processing
Frequency Filter FLL1 PLL2 Difference
200E+5" 385E+8) O0E+S =
10.00E+3 4.30E48) 0E+9 000 00E -+
1.50E+3" 1.00E+0] 1,00E+T"

Figure 5-1. GPIB Setup Area
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L

10 Port. If using GPIB, enter GPIBx where x is the address of the port where the 86100C is
located. For example, enter GPIBO. If using a LAN, enter the TCPIPx where x. For example,

TCPIPO.

Address. If using GPIB, enter the GPIB address of the 86100C. For example, enter 7. If
using a LAN, enter the 86100C host name.

Clock Recovery Location. The workbook application automatically locates the clock recov-
ery module and you do not need to enter a value into this field. However, if there are
clock recovery modules installed in both 86100C mainframe slots, you can specify which
module to use. Enter 1 if the module is in the left slot and enter 3 if the module is in the

right slot.
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Enter the 10 Port and Address for the Jitter, Clock, and Data Source instruments. For the
10 Port, when using GPIB, enter GPIBx where x is the address of the port where the 86100C
is located. For example, enter GPIB0. If using a LAN, enter the TCPIPx where x. For exam-

ple, TCPIPO.

For the Address, when using GPIB, enter the GPIB address of the 86100C. For example,
enter 7. If using a LAN, enter the 86100C host name.
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Data Rate

Loop Bandwidth

Data Rate \

Loop Bandwidth

Clock Recovery Setup

B Microsoft Excel - B6100C_400_A.01.00.xls

GPIBd
7

1‘
Jitter Source  Clock Source  Data Source

GPIEd GPIED! GPIBC

14 14 14}

Loop Peaking

£ 000E+S"
Loop Bandwidth 100.0E+T 1)
Input DIFF'

e

Measurement Setup
|anlt Configuration 1 iln) iy
Measure Loop 1 3
Default Chart )
Spectrm ) i) 1
Jitter Transfer Setup ) 18] 1)
Jitter Source 200 0E+3 300E+6 018"
Clock Source ) 5.000E+5 k)
Data Source Levels T 0.7 0.7
Diata Source Patterns 1 pros? upatd’
Post Processing [N
Frequency Filter PLL1 PLL2 Difference
2.00E+5" 385640 1.00E+5) 1.00E+)
10.00E+T = | ODE+9| 0,001
1.60E+5 1 O0E+T" 1.00E=0)

Figure 5-2. Clock Recovery Setup Area

Enter the signal’s data rate. For example, 10.000E+9 for 10 Gb/s. When measuring a
clock, the clock-recovery modules regard the clock as a data signal. A clock signal with a
101010 data pattern is perceived to have a rate that is double the clock rate. So, for clock
signals, always enter a data rate that is twice the clock rate. For example, for a typical
100 MHz PCI Express reference clock, enter 200 Mb/s. As a result, the measurable range
of clock frequencies is half the range of measurable data rates. For example, when using
an 83496B Option 200 (data rate range of 50 Mb/s to 13.5 Gb/s), the effective clock rate
range that can be tested is 256 MHz to 6.75 GHz.

The signal must be within the data rate range supported by the clock recovery module:

BBT08A ... 50 Mb/s to 13.5 Gb/s
83496B standard . ... .. 50 Mb/s to 7.1 Gb/s
83496B Option 200 . ... ... ... 50 Mb/s to 13.5 Gb/s
83496B Option 201 . ... ... 7.1 Gb/s to 13.5 Gb/s

Enter the desired loop bandwidth setting for the clock recovery module. For example,
8.0E+6. For best sensitivity when making jitter spectrum or PLL/jitter transfer measure-
ments, use the lowest loop bandwidth setting that maintains lock with your signal.
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Selects PPL loop 1 through 4 for peaking. The availability of the following settings
depends upon the loop bandwidth setting.

Selected Loop Peaking Entry Value
Automatic (default):. ... ... 0
00D T: 1
010] 172 2
00D 3. . 3
010 1 P 4

Enter one of the following strings to specify the input signal type at the clock recovery
input.

Signal Type Entry Value
Datainput: . ..o ELEC
Data UL . EINV
Differential input (default): . ... ... . . DIFF
Optical input (if supported):. . ... OPT
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Loop Response
On / Off

Default Chart

Configuration

Measurement Setup

B Microsoft Excel - B6100C_400_A.01.00.xls

I ~
gP BE- Number of Measurements

1‘
Source Setup Jitter Source  Clock Source  Data Source
GPIED' GPIED' GPIB]
14 14"

Threshold

Sample Rate

Clock Recovery Setup
Data Rate £ 000E+S"
Loop Bandwidth 100.0E+T
Input DIFF'

Measurement Setup
onfiguration

Number Of Averages
Jitter Transfer Setup
Jitter Source 200 0E+3
Clock Source i)
Data Source Levels
Diata Source Patterns
Post Processing Show Peaks
Frequency Filter PLL1
2.00E+6' 3.85E+0) 1. 00E+5) 1.00E+( Peak E .
10.00E+3' 1 S0E+E | DDE+9| 0,00 €a Xcursion
1,50E+5 1 00+ 1 00E+"
Results Viewpoint

~ vf"“ B W T T

Figure 5-3. Measurement Setup Area

Number of Measurements. Sets the maximum number of jitter spectrum measurements
the system makes before processing and displaying the averaged result for all acquisi-
tions. This is similar to setting the averaging factor for general oscilloscope waveform
acquisition. The default setting is 1. The maximum value is 32767.

Threshold. Sets the measurement threshold value. For for single measurements, enter
zero (0). This allows control of when data is saved and displayed. This parameter is based
on the magnitude of the phase error at the output of the 83496B phase detector. When
the magnitude of the error signal exceeds threshold value multiplied by the standard
deviation of the error signal, the system will stop acquiring data and display the results.
Thus the threshold value can stop acquisition prior to when the Number of Measurements
setting has been achieved. If the threshold value is never observed, the measurement will
stop when the Number of Measurements has been met. When set to 0, each phase mea-
surement will be recorded. For information on using this feature to capture a phase tran-
sient or glitch, refer to “Capturing Transients” on page 4-28.
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Default Chart
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Sample Rate. Selects the sample rate of the internal acquisition system. Selecting 40 Ms/s
enables measurement of the highest frequency jitter spectrum and phase noise possible
(3 kHz to 20 MHz offset). Selecting 4 Ms/s enables measuring as close to the carrier as
possible (300 Hz to 2 MHz offset).

Sample Rate Selection Field Value
834968
A0 Ms/s (default) ... o 0
A NIS/S 64
86108A
525 Ms/s(default). . ... 0
B.6 IS/ S . 64

Loop Response On/0ff. Controls whether or not the loop response of the clock recovery
module, having been locked to the signal being evaluated, is measured. When selected on
(default setting), the loop response is measured allowing the system to provide accurate
results via loop-response compensation and to display the dataBW worksheet as
described in “dataBW Worksheet” on page 4-26. Enter 0 if you're making multiple mea-
surements on a specific signal such that relocking is not required; earlier loop response
measurements will be valid and the loop response need not be re-measured. If the data
rate changes or the pattern of a data signal changes, the loop response should be remea-
sured.

Measurement of the Loop Response Field Value
Off 0
On(default) ... ... 1

Avoid turning the Loop Response On/Off setting to off. This feature is intended for
experienced, knowledgeable users only and could result in inaccurate measurements.

Number of Averages. Sets the number of measurements that are taken in the characteriza-
tion of the loop bandwidth of the clock-recovery module and is generally not altered by
the user. Note that this does not control how many measurements are acquired on the
test signal (achieved with the Number of Measurements parameter) and is only used as
part of the test system characterization.

Specifies which of three charts is displayed the result data. You can always display the
remaining two charts by clicking on the appropriate Worksheet tab.

Selection Field Value
Time Chart . 5
Histogram Chart. . ... ... 6
Jitter Spectrum Chart (default) . . ... ... 8

Results Viewpoint. You can select to display results from different points-of-view including
the signal at the input to the clock recovery module (setting 15), the signal observed after
passing through the PLL post processing function (setting 12), or the phase error
observed at the output of the clock-recovery module’s phase detector (setting 3). For
more information on the setting 12, refer to “Post Processing” on page 5-11.

Selection Field Value
Phase Error. . ... 3
Input Spectrum (default) .......... . 8
Post Processed (Post processing must be turnedon) .. ... ... .. 12
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Peak Excursion. Peak excursion is the ratio of the signal amplitude to the local noise floor.
The default value for this setting is 10. The peak-excursion value sets the minimum ratio
of the signal-to-noise floor to receive a marker. When the value is large, only very promi-
nent spectral lines will be marked.

Show Peak Markers. This entry allows you to display or hide peak markers on the Jitter
Spectrum Chart. Enter 1 (the default setting) to show markers on the peaks. Enter 0 to
hide the markers. Use the Peak Excursion setting to define the level needed to identify a
peak.

When periodic jitter is present, the jitter spectrum and phase noise charts may contain
spectral lines, which can become cluttered by the presense of markers. Use the Peak
Excursion and Show Peak Markers to reduce marker clutter on the chart. The show peaks
enables or disables the placement of markers.

With Show Peak Markers on, you can determine the actual energy for these periodic
tones. Simply place the computer’s cursor over a marker to display the signal level. In the
jitter spectrum chart, spectral tones are displayed in seconds-versus-frequency. The
marker will read out the jitter magnitude in seconds rms. The marker function will display
the signal’s center-of-mass, which may be composed of multiple trace points. In the phase
noise display, energy is displayed as the signal power normalized to a 1 Hz bandwidth rel-
ative to the carrier power. While this is useful for a noise spectrum, it can be problematic
for spectral tones. Trace markers are designed to show the total signal power of the tone
relative to the carrier, without being normalized to a 1 Hz bandwidth. This is similar to
how periodic modulation is displayed on a spectrum analyzer. Thus the peak markers will
be located at the x-axis position of the tone, but will be placed several dB higher than the
trace peak position. The marker readout is thus a dBc value rather than a dBc/Hz value.

e To setup averaging in the frequency domain, refer to “Averaging the Measurement in the
Frequency Domain” on page 4-30.

e To capture transients, refer to “Capturing Transients” on page 4-28.
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JTF Point
Spacing

JTF Stop
Frequency

Amplitude
Calculation

JTF Start
Frequency

Jitter Transfer Setup

After the measurement is run, the Jitter Transfer and dataJTF worksheets are displayed.

E3 Microsoft Excel - B6100C_400_A.01.00.xls Source Frequency

10 Part GPBd
L 7

Bbahde

“tack Recovery Location 1
e Setup Jitter Source Clock Source  Data Source
GPIBT GPIED GPIBC
14 i0) 14

JTF Threshold

£ 000E+5 Jitter Stimulus Amplitude

100.0E+3"
DIFF"

Source Amplitude

High
Jitter Transfer Sefirp
Jitter Saurce

Source
Settle Time

Level State

Pattern State

Jitter Source

UIUI-I'\ GIJI-III-U
[ata Source Levels

Jitter Measurement

Pattern
requency Filter PLL1
2.00E+6" 3 AEE+E
10.00E+3" 4 30E+8) .
/ 1.50E 48" fi=n) Amplitude

AN

Jitter Calibration
Pattern

Figure 5-4. Jitter Transfer Setup Area

Amplitude Calculation. This field determines how the amplitude values are calculated.
Custom frequency-amplitude pairs are used by some measurements, such as SONET/
SDH jitter transfer measurements.

Calculated Amplitude List Type Field Value
Constant amplitude level (default) . ... .. . .. 0
Custom frequency-amplitude pairs . . ... ... 1

JTF Point Spacing. Sets the number of points-per-decade used in the jitter transfer mea-
surement. The default value is 15.

JTF Threshold. This threshold value is the ratio of the measured jitter during jitter transfer
to the measured jitter spectrum at the jitter transfer frequency. By using the measured
jitter spectrum information, the measurement skips points where incorrect results may
occur due to periodic jitter inherent to the device under test. The default ratio is 20.

JTF Start Frequency. Enter the start frequency for the jitter transfer measurement.

JTF Stop Frequency. Enter the stop frequency for the jitter transfer measurement.
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Be sure to enter a start or stop frequency that is within the range of the jitter source.
Entering frequencies beyond the range of the jitter source results in innacurate
measurements.

Jitter Stimulus Amplitude. Enter the amplitude of the jitter transfer stimulus. For the
N4903A (J-BERT), this sets the peak-to-peak jitter in UI (unit intervals). For the 33250,
it sets the level in peak-to-peak volts.

Source Settle Time. Enter the wait time in seconds for source to settle before the measure-
ment is made. This allows the device-under-test to acquire lock.

Source Frequency. Enter the desired clock source frequency in Hz.

Source Amplitude. When using a separate clock source, enter the desired clock source
amplitude in dBm.

Level State. Enter 1 to control the amplitude and level of highs of the data source. This is
the default setting. Enter O to prevent selecting of levels in the data source.

Amplitude. Sets the amplitude of the data source.

High. Sets the high level of the data source.

Pattern State. Enter 1 to control the patterns of the data source. This is the default setting.
Enter 0 to prevent the selection of patterns in the data source.

Jitter Calibration Pattern. Enter the name of the pattern in the data source instrument that
will be used during the calibration of the jitter transfer measurement.

Jitter Measurement Pattern. Enter the name of the pattern in the data source instrument
that will be used during the measurement.
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Post Processing

The Post Processing fields controls algorithms that are applied to the measurement
results which can emmulate system behavior. The Low-Pass Filter Cutoff, Frequency 1, and
Frequency 2 entries shown in Figure 5-6 always effect the measurement results regardless
of the state of the post-processing on and off setting. These setting effect jitter spectrum
and phase noise measurements. When post-processing is turned off, notice that the
remaining fields are turned gray.

Post processing also allows you to pass the measured spectrum into a software model.
The measured jitter is filtered to determine the relevence of the spectral content at the
system level. The processing employs a virtual network composed of two PLLs and a
transport delay that is user definable. This configuration accomodates filter functions
from a clock recovery all the way to a complex two-path filter function as specified in
PClexpress. For example, you could model the the post processing that is used for PCI
Express reference clock. This is accomplished through use of a virtual network that
implements the PCI-Express difference function. This function is designed to assess the
impact of the jitter of a signal as it would be seen by a receiver. You define the network
using two third-order PLLs, a transport delay, and a high-pass filter. Since the PCI-
Express system uses a distributed clock, there will be a delay term altering the phase of
the receiver clock relative to the phase of the clock used at the transmitter. Also, the PPL
bandwidths of the transmitter and the receiver will not be identical. When post process-
ing is used, Histogram measurement result worksheet is displayed. Refer to “Histogram
Worksheet” on page 4-24.

PLL 2
L0 8 l
AN
Measurement + B
Results + + X,
f
PLLA1 |
—— i f _— Delay
9Pz

Figure 5-5. Post Processing Block Diagram

You enable the post-processing software model by setting the On / Off Setting to 1 (on).
When enabled, the software model is applied to the following measurements:

Jitter spectrum

Phase Noise spectrum

Jitter versus time

Frequency versus time

Jitter histogram (note that the jitter histogram is only available when post processing is
enabled)
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GPIB]
7

Clack Recovery Location 1
Source Setup Jitter Source  Clock Source  Data Source
10 Port GPIBD) GPIED GPIBC

Address 14 14 14

Clock Recovery Setup
Data Rate £.000E+9"
Loop Bandwidth 100.0E+3'
Input DIFF'

On / Off Setting

Measurement Setup
Configuration
Measure Loop

Default Chart
Spectrum PLL2 fgam
Jitter Transfer Setup
Jitter Source 200 0E+3
Clack Source

Data Source Levels
Data Source Pattems

PLL2f

Single Pole HPF
Cutoff

] Transport Delay

PLL2f

ZEro

PLLT T, PLL1f,  PLL1f

2ero

Figure 5-6. Post Processing Setup Area

Turns post processing on or off. Enter 1 to enable post processing. Enter 0 to disable post
processing.

Low-pass filter cutoff frequency for jitter-versus-time chart. Refer to “Time Domain Work-
sheet” on page 4-21.

These entries establish the frequencies for jitter integration. Frequency 1 is the low end
limit and its default value is 10 kHz. Frequency 2 is the high end limit and its default value
is 1.5 MHz. This frequency band is applied to jitter spectrum and phase noise measure-
ments even when post processing is turned off. The allowable range of the frequency val-
ues is from 300 Hz to 2 MHz (when the sample rate is 40 MS/s) or 3 kHz to 20 MHz (when
the sample rate is set to 40 MS/s.

Random jitter is determined through integration of the jitter spectrum, with the spectral
tones removed, over three different bandwidths. The first is from the first filter frequency
to the maximum frequency of the measurement (either 2 MHz or 20 MHz, depending on
the sample rate setting). The second bandwidth is from second filter frequency to the
maximum frequency. The third bandwidth is the frequency range between the two filter
settings.

These entries describe two third-order PLL models each with a gain term (f . ) which is

gain-

the frequency at which the PLL has unity gain), a pole frequency (fp ), and a zero fre-

ole

quency (f ). All values should be entered in Hertz.
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The PLLs can be defined as second order rather than third order. To create a second
order PLL, the pole frequency (fp ) for each PLL can be set to a large value, such as

1 GHz). To determine the gain and zero frequency entries from natural frequency and
damping factor, the following equations are used:

ole

gain frequency = matural frequency x damping factor x 2

natural frequency
2 x damping factor

zero frequency =

The difference function is defined by a high-pass filter frequency (Hz) and a time differ-
ence accounting for the transport delay between the two PLLs in seconds. As shown in
Figure 5-5, the transport delay is added to PLLI.
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Default Settings

IO POt . GPIBO
AArESS. . 7
Clock Recovery Location. . ... ... .. 3

Jitter Source

L0 POrt . GPIBO

ADArESS . . o 14
Clock Source

L0 POrt . GPIBO

AAArESS . . o 14
Data Source

L0 POrt . GPIBO

AAArESS . . o 14
Data Rate (bits/second) . . ... ... ..o 5.000E+9
Loop Bandwidth (Hertz) . ....... . .. . 100.0E+3
Loop Peaking. . ... ... .. 0 (automatic selection)
UL . DIFF (differential input)
Configuration

Number of Measurements . ... ... 1

Threshold. . ..o 10

SampleRate ......... ... ... ... ... ... 0 (40 Ms/s rate for 83496B or 52.5 Ms/s for 86108A)
Measure Loop

Loop Response On/Off .. ... . 1 (on)

NUMbEr OF AVEIagES . . . . oo 3
Default Chart . ... .. .. 8 (jitter spectrum chart)
Spectrum

Results Viewpoint. .. ... ... . 8 (input spectrum)

Peak EXCUTSION. . . .o 10

Show Peak Markers .. ... ... .. 1 (show)
Amplitude Calculation . ... ... ... . 0
POINt SPaCINgG . .. ..o 15
Threshold . .. 20
Jitter Source

Start Frequency (Hertz) . ... ... . 200.0E+3

Stop Frequency (Hertz) .. ... o 30.0E+6

Jitter Stimulus Amplitude (Ul or Vp-p) ... ..o 0.15
Clock Source

Source Settle TiIMe (SECONAS) . . . ..o 0.2

Frequency (Hertz). . ... .. .. o 5.000E+9

Amplitude (dBM) . ... 3
Data Source Levels

LBVEl StatE. . . o 1 (set)

Amplitude (MV) .. 0.7

High Level (mV) . ... 0.7
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Data Source Patterns
SHAE . L o 1 (on)
Pattern for Calibration ... ... ... ... .. prbs7
Pattern for Measurement. . ... ... ... upat?
Post Processing On/Off ..o 0 (off)
Low-Pass Filter Cutoff . . ... ... 2 MHz
FrEUENCY 1 .. 10 kHz
FrEOUENCY 2 . . .o 1.5 MHz
L TS 3.85 MHz
P 4.30 MHz
R 1.00 Hz
PLLZE 1.00 GHz
PLLZE 1.00 GHz
Pl 1.00 Hz
Single Pole HPF Cutoff. . .. ... 1.00 Hz
Transport Delay . . ..o Os
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Active-X Support

You can use Active-X to control the PLL and Jitter Spectrum Measurement Application
workbook. The supplied compliance-specific workbooks use Active-X to control the PLL
and Jitter Spectrum Measurement Application workbook and can be studied to learn the
techniques involved.

You can reference the fields in the Setup worksheet by a field name rather than its row
and column specifier. Figure 5-7 and Figure 5-8 identify each field and its associated
name. For Post Processing, one name (representing a 4 x 3 array) is used to specify all
the values of the Frequency Filter, PLL1, PLL2, and Difference entries. See item 8 in
Figure 5-8.
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17 1
3 Microsoft ixcel - jitter_B83496_1.01.22.xls
16 DCA Setup . 2
10 Port GPRIBO
Address 7 r
ek Recovery Docation )
Source Jitter Source  Clock' Sourgé  Data Source
10 Port GPIEd ZPIB0 GPIBO™ |
15 Address 14 14 14 / 3
Clock Recov etup
Data Rate 5,000+ /
Loop Bandwidth 100.0E+3" 0
ol DIFF
14 4
Measurement Setup /
Configdfation 1
Measure Loop 1
Default Chart g
13 Spectrum E) \ 5
12 6
11 10 9
Item | Field Name Item Field Name Item Field Name
1 DatGen_|Oport 9 sChart 16 SigGen_addr
2 DatGen_addr 10 chart 17 SigGen_|Oport
3 CR_Loop 1" meas_loop 18 Crloc
4 sRate 12 max_meas 19 GPIB_addr
5 loop_ave 13 CR_input 20 DCA_IOport
6 show_peaks 14 CR_LBW 21 ClGen_|Oport
7 threshold 15 DataRate 22 CkGen_addr
8 peak_exc

Figure 5-7. Field Names for Active-X Control (1 of 2)
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12

"

Clock Source
Data Soufce Levels
Data Source P

10

Post Processing

Frequency Filter PLY PLL2 Difference

200E+6 3B6E+ O0E+4" 1.00E+0)
10.00E+7" 4 30E+6) O0E+  000.00E+0
1 50E+6 | D0E+D) 00E+0%

8 7

Iltem | Field Name ltem | Field Name Item | Field Name
1 JTFthreshold 1 post_process 13 JTF_list
2 JTF_amp 8 OJFT 14 DatGenAmpl
3 JTF_clock_amp 9 DatGenPatState 15 JTF_clock
4 DatGenHigh 10 DatGenlevState 16 JTF_stop
5 DatGenPatMeas 1" JTF_settle 17 JTFpointspace
6 DatGenPatCal 12 JTF_start

Figure 5-8. Field Names for Active-X Control (2 of 2)
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Solving Problems
Introduction

Introduction

This chapter provides solutions to problems that you may experience while trying to con-
figure the application and perform measurements.

If the application can not control the 86100C

Confirm that you are using an 86100C with an 86108A or 83496B or 83496 AUB module.
The application does not work with an 86100A, 86100B, or 83496A.

Confirm that the 86100C software revision is A.08.00 or above. If needed, upgrade the soft-
ware revision as described in “Step 2. Upgrade 86100C software” on page 2-3.

A firewall is blocking communication via LAN on the 86100C. Refer to “Step 3. Setup the
Communications Bus” on page 2-4.

If the 86100C can not lock triggering on the signal

The clock recovery module’s loop bandwidth setting may be set too low. This can be set
by manually controlling the instrument or through the workbook’s Setup worksheet.

Set the loop bandwidth to 1 kHz which forces the 86100C to automatically select the nar-
rowest loop bandwidth setting for the selected data rate. If the 86100C fails to lock to the
input signal, increase the loop bandwidth setting.

Set the loop bandwidth to 10 MHz which forces the 86100C to automatically select the wid-
est loop bandwidth setting available at the data rate. If lock is established, reduce the loop
bandwidth until lock occurs at the narrowest loop bandwidth setting possible.
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If a clock signal can not be measured

When measuring a clock, the 86100C regards the clock as a data signal. A clock signal
with a 101010 data pattern is perceived to have a rate that is double the clock rate. As a
result, the measurable range of clock frequencies is half the range of measurable data
rates. For example, when using an 83496B Option 200 (data rate range of 50 Mb/s to
13.5 Gb/s), the effective clock rate range that can be tested is 25 MHz to 6.75 GHz.

In the workbook, set the data rate to double the rate of the clock.

If an error message occurs in Excel

Select the required Excel add-ins. Refer to “Step 6. Setup the Application” on page 2-8.

If the application stops running

Excel’s AutoRecovery feature may have been enabled. Enabling AutoRecover interupts
the application during its measurement to save recovery files. In Excel, click Tools > Op-
tions. Click on the Save tab and select Disable AutoRecover. This setting turn off this feature
for the active workbook.

Confirm that the start or stop frequency that is entered in the Jitter Transfer Setup area
of the Setup worksheet is within the range of the jitter source. Entering frequencies be-
yond the range of the jitter source results in incomplete measurements.

Press the Escape key.
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If post-processing does not work

Enable post processing. Refer to “Post Processing On/Off” on page 5-12.

If measurement noise level is too high

Reduce the clock recovery module’s loop bandwidth setting.

If the dataBW worksheet is not visible

Enable the loop response as described in “Loop Response On/Off” on page 5-7.

If the Histogram worksheet is not visible

e Enable the post processing as described in “Post Processing On/Off” on page 5-12.
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